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Preface

Dear Students,

I am pleased to present to you this course handout dedicated to the Biostatis-
tics and Informatics module for first-year medical students. In this module,
you will find a comprehensive introduction to the analysis of biomedical data
and its statistical processing using Excel and SPSS.

The content of this module is highly relevant to the current scientific challenges
in medicine and computational medicine. The effective use of medical data
and the application of statistical and computational methods are essential for
advancing the diagnosis and treatment of diseases.

That is why this handout is designed to provide you with a solid foundation
in statistics and informatics, which is essential for medical research, enabling
you to make informed decisions and to conduct high-quality research.

The purpose of this handout is to provide you with a clear and comprehensive
learning resource to facilitate your studies. Each chapter begins with a sum-
mary of the key points to remember, followed by a detailed explanation of the
concepts covered, along with numerous examples to help you fully understand
the material presented. The practical exercises included will allow you to apply
these concepts and acquire the skills necessary to succeed in our field.

In the following seven chapters, you will learn how to collect your data, prepro-
cess it using various techniques, perform advanced statistical analyses such
as analyzing relationships between variables, and work with probability dis-
tributions using SPSS. Each chapter is accompanied by practical examples to
help you better understand the concepts and techniques discussed.

We hope that this handout will provide you with a rewarding and stimulating
learning experience. We wish you all an excellent reading and great success in
your studies!

Sincerely,

Dr. Abdennour Boulesnane
Last updated on : November 30, 2025

Dpe o
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Chapter 1

Biomedical Data Analysis

1.1 Introduction

Biomedical data analysis is important because it allows researchers to identify
disease patterns, develop predictive models, facilitate drug development, en-
able personalized medicine, and integrate data from multiple sources to pro-
vide a more comprehensive view of patient health. Through these applications,
biomedical data analysis plays a crucial role in advancing our understanding
of diseases and in the development of new treatments and therapies to improve
patient outcomes.

1.2 Data Science

1.2.1 Definition

Data science is an interdisciplinary field that involves extracting, processing,
analyzing, visualizing, and interpreting large and complex datasets. It uses a
combination of statistical and computational methods to discover patterns and
insights from data that can inform decision-making and provide a competitive
advantage.

Data science involves a range of skills, including statistical analysis, machine
learning, data visualization, and data management. It often entails working
with large and diverse datasets from various sources, including social media,
e-commerce transactions, sensors, medical records, and financial data.

The goal of data science is to transform data into actionable information that
can guide decision-making, improve efficiency, and provide a competitive edge.
Data scientists use a range of tools and techniques to achieve this goal, in-
cluding data cleaning and preprocessing, exploratory data analysis, feature
engineering, model selection and validation, and data visualization.

Data science has a wide range of applications across all sectors, including
healthcare, finance, marketing, social media, and e-commerce. Examples of
data science applications include fraud detection, recommendation systems,
personalized marketing, predictive maintenance, and medical diagnosis.
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1.2. Data Science

1.2.2 Data Science Methodology

The methodology of data science is a systematic approach to solving data-
driven problems that involves several key steps (see Figure 1.1):

~

Data Collection

Data Preparation ‘

Data Analysis

Feature Engineering ‘

Model Selection and Validation ‘

Deployment ‘

¥-L-L-LL

Figure 1.1: Flowchart of the Data Science Methodology

1. Data Collection: This involves identifying relevant data sources, gather-
ing the data, and storing it in a structured format.

2. Data Preparation: This involves cleaning, transforming, and preprocess-
ing the data to make it suitable for analysis.

3. Data Analysis and Exploratory Data Analysis (EDA). EDA and data
analysis are related but distinct approaches to analyzing data.
EDA is a preliminary step in data analysis that uses various statistical
and visualization techniques to explore and understand the data. The
goal of EDA is to discover patterns, trends, and anomalies in the data
that can inform the data analysis process. EDA involves techniques such
as histograms, boxplots, scatter plots, and correlation matrices to visually
explore the data and identify key features and relationships.
Data analysis, on the other hand, is a more formal and structured process
that involves applying statistical and machine learning techniques to the
data. The goal of data analysis is to extract insights and make predictions
from the data using a well-defined methodology. Data analysis involves
techniques such as hypothesis testing, regression analysis, classification,
and clustering to model and interpret the data.
Although EDA and data analysis are distinct processes, they are often
used together in the data analysis workflow.

4. Feature Engineering: This involves selecting and transforming relevant
features or variables in the data to create new features that improve model
performance.

5. Model Selection and Validation: This involves selecting appropriate sta-
tistical or machine learning models, training them on the data, and evalu-
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Biomedical Data Analysis

ating their performance using suitable metrics and validation techniques.

6. Deployment: This step involves deploying the model into a production
environment and integrating it into the business workflow.

The data science methodology is an iterative process that involves cycling back
through these steps until a satisfactory solution is found. It requires a combi-
nation of technical skills, domain knowledge, and creativity to develop effective
solutions for complex, data-driven problems.

1.3 Computational Medicine

1.3.1 Definition

Computational medicine is an interdisciplinary field that combines principles
from computer science, mathematics, and engineering with medicine to de-
velop computational tools and models for solving health-related problems. It
involves the use of data-driven approaches, computer modeling, and simula-
tion to improve medical diagnosis, treatment, and patient care.

The goal of computational medicine is to provide personalized and precise med-
ical care through the use of data-based models and simulations. These models
can help identify risk factors, predict disease progression, and optimize treat-
ment plans. For example, machine learning algorithms can be used to analyze
medical images to detect early signs of cancer or identify patterns in large
datasets that can inform more effective treatment strategies.

Some applications of computational medicine include drug discovery and de-
velopment, medical imaging and diagnostics, predictive modeling, disease clas-
sification, and personalized medicine. Computational medicine is a rapidly
growing field with the potential to transform healthcare by providing more ac-
curate and efficient diagnostic and treatment methods.

1.3.2 Application Areas

Computational medicine has a wide range of applications across various fields,
including:

1. Medical Imaging: Analyzing medical images (MRI, CT, X-rays) to assist
in diagnosis, treatment planning, and disease monitoring.

2. Genomics and Personalized Medicine: Using genomic data to identify
disease-causing mutations, predict individual risk, and tailor treatment
plans.

3. Electronic Health Records (EHRs): Mining EHRs to identify disease pat-
terns, predict patient outcomes, and guide personalized care.

4. Drug Discovery and Development: Identifying new drug targets, design-
ing and optimizing molecules, and predicting drug toxicity.

5. Clinical Trials: Designing and analyzing trials to increase efficiency,
monitor adverse events, and improve trial outcomes.
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1.4. Data Science in Computational Medicine

6. Public Health: Tracking epidemics, forecasting disease spread, and de-
veloping prevention and control strategies.

7. Medical Devices and Sensors: Optimizing devices and wearable sensors
for diagnosis, monitoring, and treatment.

8. Health Informatics: Developing systems to improve healthcare delivery
and patient outcomes.

9. Telemedicine and Remote Monitoring: Analyzing data from telehealth
consultations and wearable devices to monitor patients remotely.

10. Predictive Analytics for Hospital Management: Using data to forecast
patient admissions, optimize staffing, and improve hospital resource al-
location.

11. Clinical Decision Support Systems (CDSS): Developing tools that help
clinicians make evidence-based decisions at the point of care.

12. Epidemiology and Population Health: Using computational models to
understand disease trends in populations and plan preventive interven-
tions.

13. Behavioral and Lifestyle Analysis: Integrating data from apps, wear-
ables, and questionnaires to study lifestyle factors and their impact on
health.

14. Rare Disease Research: Using computational methods to identify pat-
terns in rare diseases where sample sizes are limited.

15. Biomedical Literature Mining: Extracting insights from the vast biomed-
ical literature to inform research and clinical decisions.

By exploring these diverse applications, medical students can better appreciate
how computational methods and data science directly impact patient care,
research, and healthcare innovation.

1.4 Data Science in Computational Medicine

Data science plays a crucial role in computational medicine. The abundance
of medical data generated from various sources, including electronic health
records, medical imaging, genomics, and wearable devices, has created a need
for data-driven approaches to analyze and interpret this information.

Data science methods, such as machine learning, statistical modeling, and
data mining, can be used to extract patterns and insights from medical data
that inform diagnosis, treatment, and patient care. For example, machine
learning algorithms can be applied to analyze medical images to detect early
signs of cancer or to identify patterns in large datasets that can be used to
develop more effective treatment plans.

In computational medicine, data science can be used to develop predictive
models capable of forecasting disease progression or predicting patient out-
comes. Data science can also help identify risk factors and tailor treatment
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Biomedical Data Analysis

plans based on patient-specific data, such as genetic information, medical his-
tory, and lifestyle factors.

Overall, data science is a critical component of computational medicine, en-
abling researchers and clinicians to leverage the vast amounts of medical data
available to improve diagnosis, treatment, and patient care.

1.4.1 Biomedical Data

Biomedical data refers to any type of data related to human health and biology.
It can include a wide range of information, such as patient medical records,
clinical trial data, genomic data, imaging data, and many other types of health-
related information.

Biomedical data is generally used to better understand disease mechanisms,
identify potential treatments, and improve patient care. With the rise of big
data analysis and artificial intelligence, the use of biomedical data has at-
tracted growing interest for developing predictive models and personalized medicine
approaches.

However, biomedical data also raises significant ethical and privacy concerns,
particularly given the sensitive nature of the data and the potential for misuse.
As such, strict regulations govern the collection, storage, and use of biomedical
data to ensure it is handled responsibly and ethically.

1.4.2 Biomedical Data Analysis Tools
There are numerous tools available for analyzing biomedical data, including:

1. Statistical Software: Statistical software such as R, SAS, Python, and
SPSS are commonly used to analyze biomedical data, including clinical
trials and epidemiological studies.

2. Data Visualization Tools: Tools such as Tableau, MATLAB, and Excel
can be used to create visualizations of biomedical data, including charts
and diagrams, to identify patterns and trends.

3. Machine Learning and Artificial Intelligence Tools: Tools such as Ten-
sorFlow and Keras can be used to develop predictive models and identify
patterns in large biomedical datasets.

4. Genomic Analysis Tools: Tools such as GATK, SAMtools, and Picard can
be used to analyze genomic data, including DNA sequencing and gene
expression data.

5. Imaging Analysis Tools: Software such as ImageJ and OsiriX can be
used to analyze medical imaging data, including CT scans, MRIs, and
X-rays.

6. Network Analysis Tools: Tools such as Cytoscape and Gephi can be used
to analyze complex biological networks and identify relationships among
different components.



1.4. Data Science in Computational Medicine

7. Text Mining and Natural Language Processing Tools: Tools such as
PubMed and MetaMap can be used to extract information from biomedical
literature and electronic health records.

These are just a few examples of the many tools available for analyzing biomed-
ical data. The choice of tool depends on the specific needs of the researcher
and the nature of the data being analyzed.

1.4.3 Excel

Excel is a widely used spreadsheet software for data analysis and management
in many fields, including biomedical research. While Excel can be useful for
certain types of biomedical data analysis, it may not be the most appropriate
software for all types of biomedical datasets.

One limitation of Excel is its maximum number of rows and columns, which
can be a constraint when working with large datasets. Additionally, Excel
lacks built-in features for advanced statistical analysis or sophisticated data
visualization, which can limit its utility for certain types of biomedical data
analysis.

However, Excel can be useful for basic data management tasks such as data
entry, sorting, filtering, and basic calculations. It can also help generate sim-
ple tables and charts for data visualization. Furthermore, Excel can be used
to track experimental data or create basic spreadsheets to calculate simple
statistical measures, such as mean, median, and standard deviation.

1.4.4 Statistical Package for the Social Sciences (SPSS)

SPSS, which stands for Statistical Package for the Social Sciences, is software
used for statistical analysis in the social sciences, including psychology, soci-
ology, and related fields. It is a popular tool for analyzing research data and is
widely used in both academic and commercial settings.

SPSS offers a user-friendly interface for performing statistical analyses, allow-
ing researchers to easily enter data, run analyses, and generate tables and
charts to present results. Some statistical tests that can be performed using
SPSS include t-tests, ANOVA, regression analysis, factor analysis, and cluster
analysis.

SPSS also provides a wide range of data management and transformation tools,
such as sorting, merging, and recoding data, which are helpful for preparing
data for analysis.

Moreover, SPSS can be useful for certain types of biomedical data analysis,
such as survey data analysis or performing statistical tests on clinical trial
data. It provides an intuitive interface for data entry and analysis and can
generate tables and charts to present results clearly.

Overall, SPSS is a powerful and versatile tool for statistical analysis, especially
for those working in data science. It is designed to be user-friendly, even for
those with limited statistical knowledge, and can produce accurate and reliable
results.



Biomedical Data Analysis

1.5 Conclusion

Biomedical data analysis and computational medicine are rapidly evolving
fields that are transforming healthcare and medical research. By leveraging
large and complex datasets, advanced statistical methods, machine learning,
and computational models, researchers and clinicians can gain deeper insights
into disease mechanisms, improve diagnostic accuracy, optimize treatment
plans, and advance personalized medicine.

The integration of data science techniques into computational medicine en-
ables predictive modeling, pattern recognition, and evidence-based decision-
making, ultimately enhancing patient outcomes. Tools such as Excel and
SPSS play a crucial role in these processes, providing accessible platforms for
data management, statistical analysis, and visualization to support research
and clinical decision-making. Therefore, mastering these tools and methodolo-
gies of biomedical data analysis, is essential for modern medical research and
practice. These skills empower researchers and clinicians to extract meaning-
ful insights from data and contribute to the advancement of healthcare.



Chapter 2

Data Collection with Excel

2.1 Introduction

Data collection is a fundamental component of biomedical research, as it helps
generate the information and knowledge necessary to advance our understand-
ing of diseases and develop new treatments and therapies. Without proper data
collection, it would be difficult to progress biomedical research and improve
patient outcomes.

In biomedical research, Excel is commonly used for data collection. Excel is
a versatile tool that allows users to create customized spreadsheets to store
and organize data in a structured manner. It also offers features such as data
validation, formulas, and templates that help ensure data accuracy, streamline
data analysis, and standardize the data collection process.

2.2 Starting Excel

There are different ways to start Excel:

» Start Menu (Windows 7): Click the Start button =
All Programs =» Microsoft Office <» Microsoft Office
Excel 2013.

» Start Menu (Windows 11): Click the Start button
= Type "Excel" in the search bar = Select Microsoft
Excel from the search results.

» Shortcut: To make launching Excel easier, it is rec-
ommended to create a shortcut on the Desktop. Then, double-click this
shortcut to start Excel.

2.3 Terminology

Excel, Workbook, Worksheet, Column, Row, Cell, Cell Reference, Range of Cells
(see Figure 2.1).
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Figure 2.1: Excel Environment.

B An Excel file is called a Workbook. It can contain multiple worksheets
(7). By default in Excel 2013, it contains one worksheet: Sheetl. Each
worksheet consists of columns (8) and rows (9). The intersection of these
columns and rows forms cells.

B In Excel, each column is referenced by one, two, or three letters (A, B,
C, ..., XFD) — a total of 16,384 columns. Rows are numbered from 1 to
1,048,576. A cell reference is obtained by combining the column letter(s)
with the row number (without any space). For example, the intersection
of the 4th column (D) and the 6th row gives cell D6.

B By default, cells are empty, but they can contain values such as text,
numbers, or formulas.

2.4 Excel Window

H File Tab (1): In Excel 2013, the Office Button was replaced by the File tab,
located in the upper-left corner of the window. Clicking it opens the Backstage
view, which contains two main panels. The right panel shows a list of recently
used workbooks, while the left panel provides frequently used commands such
as "New", "Open", "Save", "Print", etc.

H Title Bar (2): Displays the name of the current workbook followed by the
application name (Excel). On the right, there are three buttons (10): Minimize,
Maximize /Restore, and Close.

H Quick Access Toolbar (3): Contains buttons for frequently used commands,
accessible without switching tabs. By default, it shows Save, Undo, and Redo,
but it can be customized to include commands like New, Open, or Quick Print.

B Ribbon: Located below the title bar, the Ribbon is organized hierarchically
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2.5. XLS or XLSX?

into multiple tabs (4) and contextual tabs. Fixed tabs include Home, Insert,
Page Layout, Formulas, Data, Review, and View. Contextual tabs appear when
an object is selected. For example, selecting a chart displays the Chart Tools
contextual tabs : Design, Layout, and Format. Each tab is divided into groups
containing command buttons and galleries. For example, the Home tab con-
tains groups: Clipboard, Font, Alignment, Number, Styles, Cells, and Editing.
Note: You can collapse the Ribbon by double-clicking the active tab ([Ctrl] +
[F1]):

® To temporarily display the groups, click on a tab.
® To restore the Ribbon, double-click the tab again.

B Name Box (5): Displays the address or name of the active cell (currently
selected) or selection. Only one cell can be active at a time, highlighted with a
thick border.

B Formula Bar (6): Displays the content of the active cell and allows entry or
editing of cell content.

H Fill Handle (11): The small green square at the lower-right corner of a cell.
When hovered, the pointer becomes a black cross and can be used to copy or
extend cell contents.

2.5 XLS or XLSX?

See Table 2.1.

Excel 97-2003 Excel 2007 and later (2010, 2013,
2016, 2019, 2021, 365)

In an XLS workbook, the limits are In an XLSX workbook, the limits are
65,536 rows and 256 columns, which 1,048,576 rows and 16,384 columns,

corresponds to column IV. which corresponds to column XFD.
T U v : XFB | XFC | XD A
65533 1048573
65534 1048574
65533 | 048
65536 __ ]
+ { ) ) Q. * 1 )

Table 2.1: XLS vs XLLSX in modern Excel versions.

2.6 Workbook Management

2.6.1 Create a Workbook
To create a new workbook [Ctrl]+[N]: Click File Tab => New = Blank Workbook.

10
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2.6.2 Open a Workbook
To open a workbook from Excel [Ctrl]+[O]: Click File Tab => Open.

2.6.3 Save a Workbook

Excel offers several ways to save a new workbook (physically creating it) on
your hard drive:

1. Click File Tab => Save ([Ctrl]+[S])

2. Click the floppy disk icon E on the Quick Access Toolbar ([Ctrl]+[S])
3. Click File Tab = Save As ([F12])

When using one of these save methods (1, 2, or 3) for the first time, the "Save
As" dialog appears, where you specify:

v The file name
v The drive and folder for saving

v The file type: the desired format for saving. By default, workbooks are
saved in the (.xlsx) format (Excel 2007 and later, including 2013)

2.7 Active Cell and Range of Cells

H The active cell is the cell in which data will be entered. It is distinguished
by a thicker border. By default, cell Al is the active cell when a workbook is
opened. The address (or name) and the content of the active cell are displayed
in the Name Box and the Formula Bar, respectively.

B Any rectangular block of cells is called a range of cells, or simply a range.
To refer to a range of cells, it is common to use the reference of the top-left cell
followed by a colon and the reference of the bottom-right cell.

Example:

® A1:B3 refers to the cells: Al, B1, A2, B2, A3, B3

® C1:E3 refers to the cells: C1, D1, E1, C2, D2, E2, C3, D3, E3
® Al:A8 refers to the cells: Al, A2, A3, A4, A5, A6, A7, A8

® Al:E1 refers to the cells: Al, B1, C1, D1, E1

11



2.8. Data Entry

2.8 Data Entry

Before entering data into a cell, you must first select it.

< Text

H Text is automatically aligned to the left.

B Text does not wrap automatically even if it exceeds the column width.

B To wrap text within a cell, press [Alt]+[Enter] inside the cell.

M If text begins with "+", "-", or "=", Excel will display an error message "(#N AM E?)"
because it interprets the text as a formula. To avoid this, add an apostrophe '
before the text (example: '+Medicine’).

B Add an apostrophe ' before a number to have it interpreted as text (example:
2019’ in cell A2).

< Number

B Numbers are automatically aligned to the right.

B To enter a negative number, either precede it with
theses.

B Writing 32e9 means 32 * 10°, i.e., 32 followed by nine zeros.

"non

or enclose it in paren-

< Date

B Dates are automatically aligned to the right.

B To enter a date in a cell, type it as: dd/mm/yyyy or dd-mm-yyyy.

H To enter today’s date, press [Ctrl]+[;] (this date is fixed).

B To have a date interpreted as text, precede it with an apostrophe ' (example:
’01/09/2025) (see Figure 2.2).

H ©- :
File Home Insert Page Layout Farmulas
“ Y -
b Cut Calibri - K A
BE] Copy ~
Paste P R - -
- % Farmat Painter B I U - o A
Clipboard P Font F
Ad 4 Je

A

2025 Mumber

025 Mumber i
01/09/2025 Datg

Date interpreted as text

erpreted as text

W Pa =

4 |01/09/2025

Figure 2.2: Using the apostrophe to enter text in Excel.
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2.9 Data Series

» Enter Patient in cell Al and Date in cell B1.

» Select cell Al and drag the fill handle (small square at the bottom-right
corner of the cell) down to fill several cells with consecutive entries (Figure
2.3).

» For dates in column B, Excel can automatically increment the values by day,
month, or year depending on the pattern you establish.

A B T [
1 |Patient Date
2 |P1 08/11/2025
3 |P2
4 |P3
5 |P4
6 |PS
7 |P6
8 |P7
g |P8
10|P9
11|P10
1z|P11
13|P12
14|P13
15|P14
16 [=Fis
i O Copy Cells
12 (1 Fill Series
19
20 O Fill Eormatting Only
21 O Fill Without Formatting

22 & FlashFill

Figure 2.3: Using the fill handle in Excel to complete a data series.

2.10 Validation of Statistical Variables

Variables are used to describe individuals in a population. Each column cor-
responds to a variable.

Table 2.2: Quantitative and Qualitative Variables

Types of Variables
Quantitative Qualitative
(Numeric) (Categorical)
Continuous Discrete Ordinal Nominal
Composed of numeric values | Composed of numeric values Composed of text Composed of text
that can be measured, that can be measured or labels that or labels without
but not counted (infinite). and counted (finite). have a logical order. logical order.
Example: Example: Example: Example:
Weight Number of children Tumor size Gender
{56.06 kg, 87 kg} {0, 1,2, 3,..., 10} {small, medium, large} | {Male, Female}

13



2.10. Validation of Statistical Variables

B A variable has a name: "ID", "Age", "Weight", ...
B A variable has a value at a certain point: MEDO1, 22 years, 59 kg (each row
represents an individual, statistical unit, ...)

Note:

Just because a variable is represented by numbers does not mean it is auto-
matically quantitative. Numeric values may simply serve as labels for qualita-
tive categories. For example, if we code "Male" as 1 and "Female" as 2, these
numbers only identify distinct categories and do not indicate a measurable
relationship between them.

2.10.1 Quantitative Variables

B Using the "Data Validation" window, it is possible to restrict input by impos-
ing rules such as allowing only whole numbers.

Example: For the variable Age: To restrict input to integers between O and
100, first select the relevant cells (before entering any values), for example
C2:C6 (step S1). Then go to Data — Data Tools — Data Validation (S2 and
S3). Choose Allow: Whole number (S4). Then in Data: between, type O in the
Minimum box and 100 in the Maximum box (S5) (see Figure 2.4).

Notes:

B For continuous quantitative variables, choose Decimal in the "Allow" list.

H In the "Data" list, you have several options such as: greater than, less than,
between, etc.

DATAEXCEL? - Excel

Insert  Pagelayout  Formulas ata i d Help  'Q Tell me what you want to do

eries & Connec tions 51 Y

z| Sort  Filter

F [iyFrom Text/CsV (7 Recent Sources

3 From Wel isting Connections
GEI [3 From Web [ Existing C:
Data~ [ From Table/Range

Get & Transform Data

V- Advanced

c2 - e

1 K

A B c D E
D sexe age |weight
MEDO1 |[Femme 55,5
MEDO2 [Homme 67|
MEDO3 [Homme 59
MEDO04 |[Femme 54
MEDOS [Femme 60,5

@
o

Data Validation ? X

Settings  Input Message  Error Alert

Validation criteria

@ No v s W

Allow:

B - | B gnore blank

10

1 S1 -

12

13 z

14

15 *

16 () Apply these changes to all other cells with the same settings

17

18 Clear All Cancel

19

20

21

2 -
Sheetl | Sheetz ® < ’

Ready & m 1 100%

Figure 2.4: Data validation for quantitative variables
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2.10.2 Qualitative Variables

Bl Select the cells where you will enter Sex (step E1 in the following figure) (in
our example B2:B6) (see Figure 2.5).

DATAEXCEL2 - Excel

Insert  Pagelayout  Formulas ata i i el @ Tell me what you want to do

- uf@ Y

= [BFromText/CSV [ Recent Sources

e &2

o [& From web [E* Existing Connections 3 ot | Fier Whatlf Forecast I?E Ungroup
Data~ [ From Table/Range A T Advanced Manage Data Model | apalysis~ Sheet | EE Subtotal
Get & Transform Data Forecast Outline ) -~
B2 - e v
rcles

A [ c D E o P a R s T B
1 [0 sexe age |weight
2 [mepo1 19 55,5
5 [meDo2 15} 67
4 [mEDo3 22| 59
5 [mEDoa. 18} 54
6 [meD0S 21} 60,5 7 X
d ]
z Errar Alert
)
®
1 | @ 1gnore blank
12 8 In-cell dropdown
13 <
14
15 +
16
17
:2 Apply these changes to all ather cells with the same settings
20 Qlearan Cancel
21 - - =
22 =

Sheetl | Sheet2 @ < 3

Ready = mo- ] + 100%

Figure 2.5: Data validation for qualitative variables

Next, choose Allow: List (E4) under Data — Data Validation — Data Valida-
tion (E2 and E3). Enter the list items (Homme; Femme) in the Source field
(E5), separated by a semicolon ;.

The result will be:

B2 - Je
A B C D
1 (ID sexe age |weight
2 |MEDOL ~| 19 55,5
3 |MEDO02 |Homme 18 67
— Femme
4 |MEDO3 22 59
5 |MEDO4 18 54
& |IMEDOS 21 60,5

Figure 2.6: Result of data validation for qualitative variables

Note:
B You can find the Excel data file for this chapter at: https://aboulesnane.
net/wp—-content/datafiles/DATAEXCEL2.x1sx
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2.11. Conclusion

2.11 Conclusion

Excel is a popular tool for data collection in biomedical research. To collect
data efficiently with Excel, it is important to plan your spreadsheet, use data
validation to ensure accuracy, apply formulas to streamline analysis, and se-
cure your data. Consequently, Excel can be a powerful tool to organize and
analyze data in biomedical research.

In summary, mastering Excel is an essential skill for biomedical researchers
and students, as it supports accurate data collection, facilitates initial data
exploration, and lays the groundwork for advanced analyses and reproducible
research.
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Chapter 3

Organization of the Collected
Data in SPSS

3.1 Introduction

SPSS (Statistical Package for the Social Sciences) is a powerful software tool
widely used to organize, analyze, and visualize data in social and biomedical
research. It offers a range of customizable options for data organization and
management, powerful statistical tools for data analysis, and clear and trans-
parent documentation for reproducibility.

3.2 The SPSS

The SPSS environment consists of several components, as shown in the image
below (Figure 3.1):

1. The title bar: displays the name of the current file and the application.

2. The menu bar: This bar provides access to various commands grouped
according to their function. SPSS has a number of menu options located
at the top of the screen (like any other computer program). Open SPSS
and select each menu option one by one.

4 The ‘File’ menu (shortcut Alt + F): Essentially, this menu allows
you to open existing files, create new ones, and print or save whatever
you are working on. The Recently Used Data and Recently Used Files
lists are useful because they allow you to quickly access the files you
have recently opened or worked on.

¢ The ‘Edit’ menu (shortcut Alt + E): This menu should be famil-
iar if you have used word processors before. Undo and Redo can
help correct mistakes you make. Cut, Copy, and Paste allow you to
move blocks of numbers from one part of the spreadsheet to another.
Find... and Go to Case... allow you to locate a particular data score
or participant, which is very convenient when dealing with a large
amount of data.
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3.2. The SPSS

8 Untitled1 [DataSet0] - [BM SPSS Statistics Data Editor - 8 x
File Edit View Data Transform Analyze DirectMarketing Graphs  Utilties Addons  Window  Help 2]

Visible: 0 of 0 Variables

e BB A EY B 49 3

N
]
Kl

1 ¥

1BM SPSS Statistics Processor is read Unicode:ON

Data View | Variable View

Figure 3.1: SPSS Environment.

¢ The ‘View’' menu (shortcut Alt + V): The View menu deals with
visual aspects of the spreadsheet, particularly: which toolbars are
displayed, which fonts are used, whether grid lines are visible on the
spreadsheet, whether value labels are displayed for your variables. . .,
etc.

4 The ‘Data’ menu (shortcut Alt + D): This menu allows you to or-
ganize your data file. You are unlikely to initially use most of the
options in this menu; however, a few of them may be useful. For
example, you can identify potential errors made when entering data
by flagging possible duplicate entries using the Identify Duplicate
Cases tool.

4 The ‘Transform’ menu (shortcut Alt + T): This menu allows you to
manipulate your variables.

4 The ‘Analyze’ menu (shortcut Alt + A): This is the menu you will
likely use the most and need first: Descriptive Statistics, Compare
Means, General Linear Model, Correlation and Regression. . ., etc.

¢ The ‘Direct Marketing’ menu (shortcut Alt + M): This is more for
businesses wishing to conduct market research. You will not need to
use this menu!

4 The ‘Graphs’ menu (shortcut Alt + G): This menu allows you to
present data in graphical form, which will help you better understand
your data. There are several ways to create graphs in SPSS, but this
is a good starting point.

4 The ‘Utilities’ menu (shortcut Alt + U): In practice, it is useful
for creating customized and automated analyses..., but feel free to
ignore it for now!
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Organization of the Collected Data in SPSS

4 The ‘Window’ menu (shortcut Alt + W): This menu allows you to
quickly access other windows that might be hidden.

4 The ‘Help’ menu (shortcut Alt + H): This menu can be very useful,
as it provides help and information both about the program system
itself and the statistical tests it offers.

3. The toolbar: provides shortcuts to commonly used menu commands.

4. The Data Editor window: The name at the top of each column is the
variable name, i.e., the name you will use to refer to a variable, while
each row represents an observation (a case).

5. The tabs: Data View and Variable View. Data View is where we inspect
our actual data, and Variable View is where we see additional information
about our data.

6. The status bar: at the bottom of each window, SPSS provides several
pieces of information such as command status, filter status, etc.

3.3 Data Manipulation in SPSS

B SPSS data have three main components: observations, variables, and meta-
data. When you receive data, you will rarely have a problem with the observa-
tions, occasionally a problem with the variables, but almost always a problem
with the metadata.

SPSS Data
|
Observations Variables Metadata
(Cases)

(definitions of variable
characteristics)

Figure 3.2: SPSS data.
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1\.[4 Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor — (=} X
File Edit View Data Transfom Analye DirectMarksting Graphs Utilies Add-ons Window  Help
= = - - ] = A [ ToN
‘ =] [alis BN %ﬁ @ i _JE %“éjj md @
Name Type Width | Decimals Label Values Missing | Columns Align Measure Role

9
[
q

] o

Data View | Variable View

IBM SPSS Statistics Processor is ready Unicode:ON

Figure 3.3: Variable View.

B SPSS can read data from various formats, including databases, text files,
Microsoft Excel, CSV... etc. You can also type directly into SPSS, and you can
even paste copied data into SPSS.

3.3.1 Definition of Metadata

B In SPSS, data are organized as observations (rows), and each observation
consists of a set of variables (columns). First, you define the characteristics of
the variables that make up an observation, then you enter the data into the
variables that make up the contents of the observations.

B To enter data in SPSS, use the “Variable View” tab. As you can see in the
figure below (see Figure 3.3), the attributes of the variable (such as name, type,
and width) are defined at the top of the window. All you have to do is enter
something in each column for each variable.

B The 11 characteristics are the only ones needed to fully specify all the at-
tributes of a variable. When you add a new variable, you will notice that rea-
sonable default values appear for most characteristics. The 11 characteristics
of a variable are:

1. Name: Simply click on the cell and enter a short descriptive label, such
as: Age, income, gender, patient. ... Although you can enter longer names
here, it is recommended to keep them short, as they will be used in named
lists as well as for identification labels on data graphics and other formats
where space may be limited.

¢ Variable names must begin with a letter (A-Z or a-z).

* They may contain letters, numbers (0-9), and underscore characters

0.
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#3 Variable Type x

- Decimal Places:
© Scientific notation

© Date

© Dollar

@ Custom currency

© string

© Restricted Mumeric (integer with leading zeros)

o2 The Mumeric type honors the digit grouping setting, while the Restricted

2 Mumeric never uses digit grouping.

[ DK ][Cancel][ Help ]
Figure 3.4: Variable type.

* No other special characters, spaces, or accented letters are allowed.

* The name must not be a reserved SPSS keyword, such as ALL, BY,
AND, etc.

¢ Each variable name in the same data file must be unique.
® Variable names cannot begin with a number.

2. Type: Most of the data you enter will simply be regular numbers. How-
ever, data such as currency must be displayed in a special format, and
data such as dates require special calculation procedures. For this type
of data, you just need to specify the type you have, and SPSS takes care of
the details for you. To display the dialog box shown in Figure 3.4, select
a cell in the Type column, then click the button represented by three dots
that appears.

3. Width: The Width column in the definition of a variable determines the
number of characters used to display the value. If the value to display is
not large enough to fill the space, the output will be padded with blanks. If
it is larger than what you specified, it will be reformatted to fit or asterisks
will be displayed.

4. Decimals: The Decimals column contains the number of digits that ap-
pear to the right of the decimal point when the value is displayed on the
screen.

5. Label: The name and the label share the same fundamental purpose:
they are descriptors that identify the variable. The difference is that the
name is the short identifier, and the label is the long one. You may also
choose to ignore defining the label. If you do not define a label for a
variable, SPSS will use the variable name you defined for everything.
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3.3. Data Manipulation in SPSS

6. Values: The Values column is where you can assign labels to all possible
values of a variable. To display the dialog box shown in Figure 3.5, select
a cell in the Values column, then click the button represented by three
dots that appears.

#2 Value Labels X

Value Labels

gabetl |

| ok || cancel|[ Heip |

Figure 3.5: Value Labels.

Normally, you make a single entry for each possible value that a variable
can take. But, for example, for a variable named Sex, you may assign the
value 1 to the label Male and 2 to the label Female. If you define value
labels, your output can display the labels instead of the numeric values.

To define a label for a value, follow these steps:
(a) In the Value box, enter the value.
(b) In the Label box, enter a label.

(c) Click the Add button. (The value and label will appear in the large
text block.)

(d) To modify or delete a definition, simply select it in the text block,
make your changes, then click the Change button.

(e) Repeat steps (a) to (d) as needed.
(f) To save the value labels and close the dialog box, click OK.

7. Missing: You can specify codes for missing data. To display the dialog
box shown in Figure 3.6, select a cell in the Missing column. A button
represented by three dots will appear—click it to open the dialog box.
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10.

11.

&

® No missing values
@ Discrete missing values

© Range plus one optional discrete missing value

[ OK ][Cancel][ Help ]

Figure 3.6: Missing values.

For example, suppose you are entering responses to questions, and one of
the questions is: “How many children do you have?” The normal answer
to this question is a number, so you define the variable type as numeric.
You may define —-99 as the value entered when the response is “I don’t
remember,” and -98 when the response is “I cannot say.”

Columns: In the Columns attribute, you can specify the width of the
column used to enter the data.

. Align: The Align column determines the position of the data within its

allocated space.

Measure: Your value for the Measure attribute specifies the level of mea-
surement of your variable. Here are the measurement level options in
SPSS:

B Nominal: A value that specifies a category or type of thing. For
example, you may use O for Disapprove and 1 for Approve, or 1 to

indicate Female and 2 to indicate Male.

B Ordinal: A value that specifies the position (order) of something in a
list. For example, first, second, and third are ordinal numbers.

B Scale: A number that specifies a magnitude. The scale may represent
distance, weight, age, or a count of something.

Role: You do not need to worry about the Role column for now.

3.4 Entering and Displaying Data Items in the “Data

View” Tab

After defining the variables, you can begin entering the data. Click on the Data
View tab in the Data Editor window. At the top of the columns, you will see
the variable names. Entering data into any of these cells is simple: just click
the cell and start typing.
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3.5. Saving SPSS Data

3.5 Saving SPSS Data

All you need to do is choose File = Save or Save As (Ctrl + S), select your file
type, and then enter a file name. The SPSS Statistics file format is “.sav” (see
Figure 3.7).

Lookin: | = Documents ~ | [ 38 =

Camtasia Studio SlicerDICOMDatabase
Custom Office Templates Zoom
IBM
LetsView
MATLAB
Modéles Office personnalisés
ﬂ My Shapes
Python Scripts

Keeping 1 of 1 variables. Variables_..

File name: Untitled1 |

Save

Save as type: |SPSS Statistics (*.sav) =

Cancel

Help

1)

O E A

[T] Encrypt file with password

Store File To Repository...|

Figure 3.7: Saving Data in SPSS.

You have many file types to choose from: plain text formats, Excel spreadsheet
formats, Lotus formats, dBase formats, SAS formats, SYLK format, Portable
format, and 18 Stata formats.

3.6 Opening SPSS Data Files

To open a data file, choose File = Open =» Data (Ctrl + O) and select the file
to load. When you do this, the variable names and the data are loaded into
SPSS.

3.7 Transferring Data from an Excel File to SPSS

To open your Excel file in SPSS:
1. File - Open -» Data (Ctrl + O) from the SPSS menu.

2. Select the file type you want to open: Excel .xls, .xlsx, .xlsm.
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u Open Data

' Lookin: |‘ Desktop v| ER

*

= Documents + Downloads
@ This PC 2 Music
& Network @ OneDrive
__ Libraries P9 Pictures
A callery B3 videos

User
2 Desktop

hakim

MNew folder

0Doo

Pdfs

VOSviewer_1.6.20_exe

. File name:

| Files oftype: |SPSS Statistics (*.sav)

SPSS Statistics (*.sav)

SPSS Statistics Compressed (*.zsav)
SPSSIPC+ (*.sys)

Systat (*.syd, *.5ys)

Portable (*.por)

Excel (*xls, *xlsx, *xlsm)

Lotus (*.w*)

T Tl
I <1

[ Minimize

Figure 3.8: Opening Data in SPSS.

3. In the “Open Data” dialog box, select the file you want to open (see Figure

3.8).
4. Click Open.

5. The following dialog box appears (Figure 3.9).

u Opening Excel Data Source

. D\Medicine Faculty\TPs 2023 TP2\DATAEXCELZ xlsx
You can specify a

range of cells to be [¥ Readvariable names from the first row of data

read.

Range: | |

Maximum width for string columns: 32767

(o ) cara e

Figure 3.9: Open the Excel Data Source.

6. Click OK.

Note:

Worksheet: |Sheet1 [A1:DE] - j

An Excel file may
contain several
worksheets. By

default, the Data

Editor reads the first

worksheet. To read

another worksheet,
select it from this

menu.

H You can find the SPSS data file for this chapter at the following link: https:
//aboulesnane.net/wp-content/datafiles/DataSPSS3.sav
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3.8. Conclusion

3.8 Conclusion

Organizing collected data in SPSS is important for accurate and efficient data
management, research reproducibility, data security and confidentiality, and
collaboration among researchers. SPSS offers a user-friendly interface and
customizable options for organizing data, such as recoding, data transforma-
tions, and data cleaning. SPSS enables fast and efficient data management,
including the ability to import and export data from various sources, merge
datasets, and clean data. Overall, organizing collected data in SPSS is es-
sential for conducting reliable and valid research in the social and biomedical
sciences.
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Practical Works

TP 1

Objective

In this practical session, we will learn how to create an Excel file containing
multiple quantitative and qualitative variables. We will also focus on learning
how to validate the entered data to ensure its accuracy.

Exercise
A E C D E
1 |Patient [Age [Sexe Blood Temperature
2 |P1 T7|Femme B 74
3 P2 B4 |Homme A 38
4 |P3 87| Homme AB 38,5
3 (P4 T0Femme A 38,2
g |P5 85|Femme ] 38,1

1. Create an Excel data file with different types of variables (qualitative and
quantitative):

(a) Create a new Excel data file.

(b) The dataset should contain five variables named: Patient, Age, Sex,
Blood, and Temperature (see the figure above).

(c) Enter the data for the "Patient" variable from P1 to P5 using the fill
handle.

2. Before entering data for the variables Age, Sex, Blood, and Temperature,
ensure that each variable is properly validated:

(@) Check the validity of quantitative variables (Age, Temperature).
(b) Check the validity of qualitative variables (Sex, Blood).
3. Save the resulting Excel file as Tpl.x1lsx.

4. Delete the variable "Temperature" and save the dataset in another file
called Tpl_2.x1sx.
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Solution

1.

(a) Open Microsoft Excel.

(b) In the first row, enter the names of the five variables in each column:
Al: Patient, B1: Age, C1: Sex, D1: Blood, and E1: Temperature.

(c) Select cell A2 = Enter P1 = drag the fill handle down to A6 to fill the
patient IDs.

(@) For the discrete quantitative variable Age: select the cells B2:B6 =
Data =» Data Validation = Choose Allow: Whole number = Data:
between = Minimum: 1 = Maximum: 120 =% OK.

(b) For the continuous quantitative variable Temperature: select the
cells E2:E6 = Data =» Data Validation =* Choose Allow: Decimal =»
Data: between = Minimum: 29.5 =% Maximum: 42.3 =% OK.

(c) For the qualitative variable Sex: select the cells C2:C6 =» Data = Data
Validation =¥ Choose Allow: List =% Source: Homme;Femme = OK.

(d) For the qualitative variable Blood: select the cells D2:D6 =¥ Data =
Data Validation =¥ Choose Allow: List =» Source: AB;A;B;O = OK.

(e) Fill in the data as shown in the figure above.

3. File Tab =» Save = File name: Tpl.xlsx =¥ Save.

4. Select column E = press the "Delete" key =» File Tab =* Save As =¥ File

name: Tpl_2.x1lsx =¥ Save.

For more details, refer to Chapter 2.
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